QUICKBOOKS DESKTOP 2018 STUDENT GUIDE

Lesson 2

Setup
Copyright

Copyright 2018 Intuit, Inc. All rights reserved.
Intuit, Inc. 5601 Headquarters Drive
Plano, TX 75024

Trademarks

©2018 Intuit, Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte, ProAdvisor, ProSeries and QuickBooks, among others, are trademarks or registered trademarks of Intuit, Inc. in the United States and other countries. Other parties’ marks are the property of their respective owners.

Notice to Readers

The publications distributed by Intuit, Inc. are intended to assist accounting professionals in their practices by providing current and accurate information. However, no assurance is given that the information is comprehensive in its coverage or that it is suitable in dealing with a client’s particular situation. Accordingly, the information provided should not be relied upon as a substitute for independent research. Intuit, Inc. does not render any accounting, legal or other professional advice, nor does it have any responsibility for updating or revising any information presented herein. Intuit, Inc. cannot warrant that the material contained herein will continue to be accurate nor that it is completely free of errors when published. Readers should verify statements before relying on them.
Table of Contents

About the Author.................................................................................................................................................. 5
Lesson Objectives.................................................................................................................................................. 6
Create a QuickBooks Company .......................................................................................................................... 7
Start the EasyStep Interview.............................................................................................................................. 8
Enter Company Information .............................................................................................................................. 9
Choose Your Company Industry ...................................................................................................................... 10
Select How Your Company is Organized .......................................................................................................... 11
Customize QuickBooks for your Business........................................................................................................ 12
Indicate What You Sell......................................................................................................................................... 13
Enter Sales Information....................................................................................................................................... 14
Enter Sales Tax Information............................................................................................................................... 15
Create Estimates.................................................................................................................................................. 16
Create Sales Orders............................................................................................................................................. 18
Choose Remaining Preferences......................................................................................................................... 19
Choose a Start Date............................................................................................................................................ 21
Review the Chart of Accounts........................................................................................................................... 22
Enter Bank Accounts and Opening Balances.................................................................................................... 25
Complete Company File Setup.......................................................................................................................... 27
QuickBooks is Based on Four Key List Concepts.............................................................................................. 27
Add Customers..................................................................................................................................................... 28
Add a Job............................................................................................................................................................. 31
Lesson 2 – Setup

Add Vendors .................................................................................................................. 33
Set Up Additional General Ledger Accounts ................................................................. 35
Add Items ....................................................................................................................... 38
Enter Historical Transactions ....................................................................................... 41
Set Up QuickBooks – Review Questions ....................................................................... 42
Answers to Review Questions ....................................................................................... 44
About the Author

Esther Friedberg Karp, MBA
President, EFK CompuBooks Inc.

Esther Friedberg Karp is an internationally-renowned trainer, writer, business consultant and speaker who was named one of the Top 10 QuickBooks ProAdvisors in the world, with the title Top International ProAdvisor.

Based in Toronto, Canada, Esther has the unique distinction of holding ProAdvisor certifications in the United States, Canada and the United Kingdom. She has authored materials and delivered educational and certification courses for Intuit in all those countries, as well as Australia where she conducted live QuickBooks Online training. She has spoken at Scaling New Heights, QuickBooks Connect and other conferences, as well as those of various accounting and professional organizations and written countless articles for Intuit Global.

Esther counts among her clients’ companies from around the world, as well as accounting professionals who seek her out on behalf of their own clients for her expertise in various countries’ editions of QuickBooks Desktop and Online, and for her talent in customizing QuickBooks usage for different industries.

Esther holds a BSc from the University of Toronto in Actuarial Science and Mathematics, and an MBA in Marketing and Finance from York University’s Schulich School of Business.

She can be reached at esther@e-compubooks.com or 416-410-0750.
Lesson Objectives

- Discuss decisions that must be made before using QuickBooks
- Create a new QuickBooks company using the EasyStep Interview
- Set QuickBooks preferences in the interview
- Record the opening balance for a checking account
- Enter customers, jobs, vendors, accounts and items for a QuickBooks company
Create a QuickBooks Company

A QuickBooks Desktop company contains all the financial records for a single business. Before you can use QuickBooks, you need to tell QuickBooks about your business, so it can set up your company file properly.

1. Express Start will set up a new company file based on some standard industry settings. (Any fine-tuning of the company file can be done later.)

2. Detailed Start opens the EasyStep Interview and will give you more control over fine-tuning your company file as you set it up.

3. Your other options are to create a file by copying list data from an existing file or by converting data from another accounting system.

In the Detailed Start option, you will set up the following using the EasyStep Interview:

- Company information
- Chart of Accounts based on your industry
- Company organization
- Sales information
- Sales tax information
- Estimates
- Sales receipts
- Preferences
- Business start date
- Create an account and enter the opening balance
- Review the Chart of Accounts
- Complete company file setup
Start the EasyStep Interview

**Step-by-Step: Begin to Add a New Company**


2. Click the **Create a new company file** button from the No Company Open window or choose **New Company** from the File menu.

3. Click the **Detailed Start** button to start the EasyStep Interview.

4. QuickBooks displays the EasyStep Interview window.

**NOTES**
Enter Company Information

**Step-by-Step: Create a New QuickBooks Company File**

1. At the first Welcome window for the EasyStep Interview, the Enter your company information window appears.

2. Enter the business name in the Company name field and press **Tab**.
   
   When you press **Tab**, QuickBooks automatically enters that name into the Legal name field. QuickBooks uses the company name on all reports.

3. Press **Tab** again and enter the EIN or SSN in the Tax ID field.

4. Complete the remaining contact information for the company. QuickBooks will pull this information onto sales forms and tax reports when you begin working in the file.

   Your screen should resemble the following.

![QuickBooks Company Information Screen](image.png)

5. Click **Next**.
Choose Your Company Industry

**Step-by-Step**: Choose your Company Industry to Create a Chart of Accounts

1. Choose your industry from the list to help QuickBooks compile a suggested Chart of Accounts for your business.

![EasyStep Interview](image)

2. Click **Next**.

**NOTES**
Select How Your Company is Organized

**Step-by-Step: Select your Company Organization**

1. Choose the company’s entity type (for example, Sole Proprietorship, S Corporation, LLC, etc.). This will allow QuickBooks to create suggested tax mapping for your Chart of Accounts.

2. Click **Next**.

3. Enter the beginning month of the business’s fiscal year – commonly January. (Remember: if a company’s year-end is December, you would enter January as the first month of the year.) Then click **Next**.

4. In the Set up your administrator password window click **Next**. You can set the password later. If you don’t set up a complex password (seven characters, including at least one upper case character and one number) now, you’ll be prompted to do so the next time you open this company.

5. Click **Next** to save the company file.

6. Name your company file (it ends in .QBW) and choose the location on your computer where you wish to save it.

7. Click **Save**.

**NOTES**
Customize QuickBooks for your Business

After you’ve saved the company data file, the customization section of the EasyStep Interview appears. It is the place where you indicate:

- What you sell
- How and when your customers pay you
- How you pay your bills

Based on your answers, QuickBooks sets preferences for the company file. The preferences enable certain features of the QuickBooks program.
Indicate What You Sell

You need to indicate what your business sells. In general, businesses either sell products, services or both. Margaret Lockhart provides consulting services as well as selling products such as fabrics.

**Step-by-Step: Indicate What You Sell**

1. Click **Next** to move to the What do you sell? window.
2. Choose the appropriate option for the business (services only, products only, or both services and products).

3. Click **Next**.

**NOTES**
Enter Sales Information

Retail companies need to indicate how they want to enter sales. QuickBooks uses this information to set recommendations for a retail-type business. (Note: you may have encountered these windows in the EasyStep Interview if you chose a different type of business other than retail.)

Step-by-Step: Indicate How you Enter Sales (for Retail Companies)

1. In the How will you enter your sales in QuickBooks? window, choose the option that best fits the business's needs.

2. Click Next.

NOTES
Enter Sales Tax Information

This part of the EasyStep Interview asks whether you charge sales tax. You should turn the sales tax setting off only if you never charge sales tax. Sometimes it is even beneficial to turn this feature on for tracking wholesale/retail sales, depending on the tax reporting regulations in your state.

**Step-by-Step: Set up QuickBooks to Track Sales Tax**

1. Click *Yes* in the Do you charge sales tax? window.

![EasyStep Interview with sales tax options]

2. Click *Next*.

**NOTES**
Create Estimates

If you provide any type of estimate or bid – even a verbal quote – there are many reasons to use estimates in QuickBooks. With QuickBooks estimates you can do the following:

- Prepare professional-looking itemized estimates, bids, quotes or proposals for your customers
- Create an invoice from the estimate with just one click; QuickBooks then creates and populates an invoice for this customer using details from the estimate you used for that customer
- Create reports that compare your estimated costs and revenue against your actual costs and revenue
- Compare your actual costs against what you estimated
- Track which estimates are still active and easily update each estimate as you continue to negotiate with your customers
Step-by-Step: Create Estimates for Your Business

1. On the Do you want to create estimates in QuickBooks? window, choose the option that best fits the business.

2. Click Next.

NOTES
Create Sales Orders

Sales orders allow you to record an order for a sale before the sale is actually made. These forms are common in businesses that order products to fill orders or that pull orders from inventory before invoicing. (Think of these forms as “incoming purchase orders” from customers.) These forms enable you to create partial invoices for an order if you have inventory items on backorder.

Step-by-Step: Create Sales Orders for Your Business

1. On the Tracking customer orders in QuickBooks window, choose the option that best fits the business.

![Tracking customer orders in QuickBooks](image)

Do you want to track sales orders before you invoice your customers?

- Yes: recommended for your business
- No

Tip! You can change a sales order to an invoice with one click.
Choose Remaining Preferences

The next series of windows asks Yes or No questions that either enable or disable different QuickBooks features based on your company’s needs. Simply click Yes or No, then click Next to move forward in the Interview.

<table>
<thead>
<tr>
<th>OPTIONS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>BILLING STATEMENTS</td>
<td>Post statement charges independently of invoices and sales receipts</td>
</tr>
<tr>
<td>PROGRESS INVOICING</td>
<td>Create single estimates to be invoices in phases</td>
</tr>
<tr>
<td>BILL TRACKING</td>
<td>Use the accounts payable module to track bills and bill payments</td>
</tr>
<tr>
<td>INVENTORY</td>
<td>Use the inventory module to track inventory quantities and values</td>
</tr>
<tr>
<td>TRACK TIME</td>
<td>Use timecards to track employee and subcontractor time</td>
</tr>
<tr>
<td>EMPLOYEES</td>
<td>Use payroll module to manage employee information and payroll</td>
</tr>
</tbody>
</table>
You can always change preference settings after the EasyStep Interview has been completed. To change the preferences later, access the Edit menu, choose **Preferences**, then select the preference type in the left panel.

**NOTES**
Choose a Start Date

The start date is the date you give QuickBooks a financial snapshot of your company assets and liabilities before you start entering live transactions. It is generally the last day of the previous fiscal period.

**Step-by-Step: Choose a Start Date**

1. On the Using accounts in QuickBooks window click **Next**.
2. Choose the option that best suits the business setup.

3. Click **Next**.

**NOTES**
Review the Chart of Accounts

The Chart of Accounts is made up of five types of accounts common to all businesses – the income and expense accounts used by the Profit and Loss Statement, and the asset, liability and equity accounts used by the Balance Sheet. Each time you enter a transaction, QuickBooks will prompt you to categorize it into one of these five accounts.

Because you chose an industry from the list earlier in the Interview, QuickBooks has already created income and expense accounts for your company based on that choice. You can add, delete or modify accounts long after you make this choice. QuickBooks is very flexible that way.

Step-by-Step: Review the Chart of Accounts

1. In the Review income and expense accounts window, scroll through the preset accounts to get an idea of what is included. Modify the selections according to your business needs by adding or removing checkmarks.

2. Click Next.
Congratulations! You have completed the EasyStep Interview.

You now have a company file with customized settings for your business.
Next we'll help you enter your critical business info using QuickBooks Setup.
3. Click **Go to Setup**.

The QuickBooks Setup screen appears.

![QuickBooks Setup Screen]

After you have completed the EasyStep Interview, use the information in the Help options described later in this document to help you make changes and adjustments to your company file.

**NOTES**
Enter Bank Accounts and Opening Balances

The balance sheet accounts in the QuickBooks Chart of Accounts start with an opening balance of zero. Before you begin working in QuickBooks, you need to enter an opening balance for each balance sheet account as of your start date.

Step-by-Step: Enter Bank Account Information

1. On the Add your bank accounts section of QuickBooks Desktop Setup screen, click Add.
2. Name each bank account in the Account name column. Be descriptive with businesses that have multiple bank accounts to eliminate confusion.
3. If you are using account numbers in QuickBooks (to identify the categories in the Chart of Accounts), be sure to enter the corresponding number in the Account number column. This is not where you enter the actual bank account number from the bank!
4. For Opening balance, enter the balance in the account as of the date you are beginning the file.
5. For Opening balance date, use the date you are using to begin the file. The opening balance amount should reflect the balance in the Opening balance date column.
**IMPORTANT:** The above action creates an increase to your checking account balance and an increase to your opening balance equity account balance.

6. Click **Continue**.

7. In the Order Checks screen, select **No Thanks** (or Yes, remind me later) then click **Continue**.

8. If you selected **Yes, remind me later**, you will see a Create Alert screen regarding printing checks.

9. Click **Start Working**.

10. Close the Quick Start Center and you’re ready to work in QuickBooks.

**NOTES**
Complete Company File Setup

After you have created your company file using the EasyStep Interview, you can begin using QuickBooks to run your business.

However, there are some additional tasks you might need to do to make sure the company file is properly set up and the data is complete.

The upcoming screen captures were created using one of the QuickBooks sample companies that comes installed with QuickBooks Desktop, rather than the new company that was created earlier in this lesson.

**QuickBooks is Based on Four Key List Concepts**

- Accounts
- Items
- Customers & Jobs
- Vendors

**Notes**
Add Customers

The Customer Center is the dashboard that can launch sales forms (sales orders, estimates, invoices, sales receipts, statement charges, receive payments and credit memos/refunds) and display accounts receivable.

**Step-by-Step: Add a Customer**

1. There are multiple ways to do almost anything in QuickBooks. To access the Customer Center you have four options:
   - Click **Customers** from the left-hand or top icon bar (depending on your View settings)
   - Choose **Customer Center** from the Customers drop-down in the menu bar
   - From the Home page, click the blue **Customers** tab in the Customers section
   - Press **CTRL+j**

2. Click the **New Customer & Job** menu button, then choose **New Customer**.

3. In the Customer name field, enter the name of the customer as you'd like it to appear on your Customers & Jobs list.

4. Press **Tab** past the Opening balance field to leave this field blank.

   The Opening balance field tells you how much each customer owes you on your start date so that when you enter the rest of your transactions from the day after your start date to today, all balances since your start date will be accurate.

**IMPORTANT:** It is recommended to enter individual outstanding invoices one by one whenever possible, rather than entering the outstanding balance owed in the Opening balance field.
5. Complete the customer contact information appropriately.

   You can have and use more than one Ship To address per customer or job. Add them with the Ship To drop-down or by clicking the + sign in the bottom right corner.
6. Click **OK** to add this customer. The Customer Center appears with the Customers & Jobs list along the left side. (New names appear at the top of the list. Right-click on the list and choose **Re-sort List** in order to return all the names on this list to alphabetical order.)

**IMPORTANT:** The Customers & Jobs list is the same list as the Customer/Job list. It is called Customers & Jobs on the Customer Center and called Customer/Job on forms. It is sometimes also referred to as simply the Customer list.

**NOTES**
Add a Job

You do not need to add jobs to the Customers & Jobs list if your company never does more than one job or project per customer. Jobs in QuickBooks are optional. If you often perform multiple jobs for the same customer, you can use jobs in QuickBooks to track the activity for each job separately.

The Customer:Job hierarchy can be customized to meet many different needs and is commonly used in construction. This feature enables you to use the Customer as a parent under which you group multiple jobs. (Another common use of jobs is for attorneys who handle more than one matter for each client.)

**Step-by-Step: Add a Job for a Customer**

1. In the Customers & Jobs list, right-click on the customer name you would like to add a job for and choose **Add Job**.

2. Name the job in the Job name field.

3. For the Opening balance, refer to the information in **Add a Customer** in the previous chapter.
4. Click **OK**.

5. The job will now appear under the Customer (also referred to as parent) in the Customer list.

6. Close the Customer Center by clicking the **x** in the top right corner of the Center (not the top right corner of QuickBooks, which will close the program!) or by hitting the **Esc** key.

**IMPORTANT:** Notice there are more tabs with information you can add for Customer:Job setup. These features include payment information, sales rep and job status. It is important to understand your tracking and reporting goals to ensure these features are set up and utilized properly.

**NOTES**
Add Vendors

In order to pay your bills with QuickBooks, you need to add your vendors (sometimes referred to as suppliers). Nearly everyone you pay, other than employees, is a vendor. Your Vendor list supplies the names available on purchase forms like purchase orders, vendor credits, sales tax payments, payroll tax payments and bills.

**Step-by-Step: Add a Vendor**

1. Just like the Customer Center, there are multiple ways to access the Vendor Center in QuickBooks.
   - Click on **Vendors** from the left side or top icon bar (depending on your View settings)
   - Choose **Vendor Center** from the Vendors drop-down in the menu bar
   - From the Home page, click on the **Vendors** tab in the Vendors section

2. Click the **New Vendor** button then choose **New Vendor**.

3. In the Vendor name field, enter the name of the vendor as you'd like it to appear on your Vendor list.

   **IMPORTANT:** In the Opening balance field, this is treated the same as the Customer Center entries. You can enter a balance owed to the vendor as of the start date of the file, but it is a best practice to enter individual open bills whenever possible.

4. Enter the remaining vendor information appropriately.
5. Click **OK** to add this vendor.

   The new vendor appears on the Vendor list. (New vendors automatically appear in their correct alphabetical order in the Vendor list.)

6. Close the Vendor Center by clicking the **x** in the top right corner of the Center (not the top right corner of QuickBooks, which will close the program!) or by hitting the **Esc** key.

**IMPORTANT:** Notice there are additional tabs in the Vendor setup window. Feel free to utilize these features as they apply to your business. Pay special attention to the Tax Settings tab if you would like to run 1099 reports from QuickBooks.

**NOTES**
Set Up Additional General Ledger Accounts

During the EasyStep Interview, you added your bank accounts. Bank accounts are one specific type of general ledger account.

There are two categories of general ledger accounts:

- Balance sheet accounts, which include bank accounts and other asset accounts, liabilities and equity accounts
- Profit and loss (also known as income statement) accounts, such as income and expense accounts

Income and expense accounts track the sources of your income and the purpose of each expense. When you record transactions, you usually assign the amount of the transaction to one or more income or expense accounts.

General ledger accounts are the core of QuickBooks. Every posting transaction (which is a transaction that affects the general ledger) is mapped from one account to another. For example, when you purchase paper for your office printer you are taking money from the bank account and recording it against an office supplies expense account. Your Chart of Accounts is home to all the general ledger accounts (also referred to as categories) that appear on your financial reports.
Step-by-Step: Add an Account

1. From the Lists menu, choose Chart of Accounts (or press CTRL+a).

2. Click the Account menu button (at the bottom left of the window) and choose New (or press CTRL+n from the Chart Accounts window).

3. In the Add New Account window, choose the appropriate account type then click Continue.

4. If account numbers have been enabled in the Accounting Preferences (Edit → Preferences → Accounting → Company Preferences → Use account numbers), you will be able to enter the account number in the Number field.

5. Click in the Account Name field and name the account appropriately.

6. If it's a subaccount of another account of the same type, check the Subaccount of checkbox and specify the parent account.

7. Optionally, use the Description field to add a description.

8. From the Tax Line Mapping drop-down list, choose the appropriate mapping according to the business structure (or leave blank if you are unsure) to help in preparing income taxes for the company.
9. Click **Save & Close**.

**NOTES**
Add Items

Items are what we use on sales forms like estimates, sales orders, invoices and sales receipts. Items show the products/services that are sold and each item is mapped to one or more accounts in QuickBooks. Items can be mapped to one, two or three accounts in QuickBooks, depending on the item setup.

- **One-sided Items** – These items are used only on either a sale or a purchase form, not both. For example, if you sell consulting services, you may have an item named Consulting for use on your invoices. This item will be mapped to an income account to view on your Profit & Loss report. If this item were used on a purchase transaction, it would post a negative transaction to your income account.

- **Two-sided Items** – These items are used on both a sale and a purchase form. The setup for these items allows you to post to an income account when used on a sales form and post to an expense account when used on a purchase form.

- **Three-sided Items** – Three-sided items are used for inventory. The setup of these items allows you to purchase the item and receive it into your Inventory Asset account (part 1). When you sell the inventory, the item posts to your Income account (part 2) and makes a Cost of Goods Sold entry (part 3).

In this section, we will look at a one-sided item entry.
**Step-by-Step: Add a One-sided Item**

1. From the Lists menu, choose **Item List**.

2. Click the **Item** menu button at the bottom left of window and choose **New**.
3. In the New Item window, choose an item type from the Type drop-down list.

**IMPORTANT:** When you select an item type, a description of how that item should be used will appear to the right of the drop-down box.

4. Assign an item name or number in the Item Name/Number field.

5. In the Description field, enter the information you would like to appear by default when this item is used on a form. (This default information can be overwritten on any individual transaction.)

6. You can assign a standard per unit selling price in the Rate field.

7. In the Tax Code field, assign a standard taxable or non-taxable code.

**IMPORTANT:** Items marked non-taxable in the setup will not accrue sales tax on sales forms. See the Sales Tax training section for additional information.

8. In the Account field, choose the appropriate income account to post to when this item is used on sales forms.

9. Click **OK** to add the new item to the Item List.

10. Close the Item List.
Enter Historical Transactions

If your QuickBooks start date for a new business (starting to record transactions in QuickBooks from the very inception of the business) is before today’s date, you need to enter past transactions so you have complete financial records from the start date going forward. (Existing companies that have been in business for some time before starting to use QuickBooks will require more steps.)

Step-by-Step: Enter Historical Transactions in this Order

1. All sales (sales receipts, invoices, credit memos or statement charges) issued on or after the start date.
2. Customer payments received for outstanding invoices on or after the start date.
3. Bills and bill credits (also known as vendor credits) received on or after the start date.
4. Bills paid since the start date.
5. Deposits made to any of the accounts on or after the start date.
6. Any other checks written and credit card charges made (other than to pay bills), as well as bank charges and pre-authorized payments on or after the start date.

NOTES
Set Up QuickBooks – Review Questions

1. During the EasyStep Interview, QuickBooks creates income and expense accounts based on your company’s ________________.

2. When setting up a company file in QuickBooks, what does the start date signify?
   a. The date the business was created
   b. The first date of the company’s fiscal year
   c. The date the company purchased QuickBooks
   d. The date from which you will be entering transactions in QuickBooks

3. When setting up a company file in QuickBooks at the beginning of a fiscal period, you would normally select which of the following as the start date?
   a. The first day of the current fiscal period
   b. The last day of the previous fiscal period

4. True or false: Once you have set up the Chart of Accounts, you cannot add, delete or modify accounts.
   a. True
   b. False

5. Before working in QuickBooks, you need to enter an ____________ ____________ for each balance sheet account.

6. True or false: Choosing a company organization associates a tax form with your business in the QuickBooks file.
   a. True
   b. False
7. In QuickBooks, linking income and expense accounts with tax lines does which of the following?

   a. Helps keep your company profitable
   b. Helps in preparing income taxes
   c. Helps keep track of sales taxes you owe
   d. Both b and c
Answers to Review Questions

1. During the EasyStep Interview QuickBooks creates income and expense accounts based on your company’s industry.

2. When setting up a company file in QuickBooks, what does the start date signify?
   a. The date the business was created
   b. The first date of the company’s fiscal year
   c. The date the company purchased QuickBooks
   d. ✓ The date from which you will be entering transactions in QuickBooks

3. When setting up a company file in QuickBooks at the beginning of a fiscal period you would normally select which of the following as the start date?
   a. The first day of the current fiscal period
   b. ✓ The last day of the previous fiscal period

4. True or false: Once you have set up the Chart of Accounts you cannot add, delete or modify accounts.
   a. True
   b. ✓ False

5. Before working in QuickBooks you need to enter an opening balance for each balance sheet account.

6. True or false: Choosing a company organization associates a tax form with your business in the QuickBooks file.
   a. ✓ True
   b. False
7. In QuickBooks, linking income and expense accounts with tax lines does which of the following?
   
   a. Helps keep your company profitable
   b. **Helps in preparing income taxes**
   c. Helps keep track of sales taxes you owe
   d. Both b and c